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Part Number E2925-91010

Notice
The information contained in this document is subject to change without notice.

HEWLETT-PACKARD MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS
MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Hewlett-Packard shall
not be liable for errors contained herein or for incidental or consequential damages in connectio
the furnishing, performance, or use of this material.

Hewlett-Packard assumes no responsibility for the use or reliability of its software on equipmen
is not furnished by Hewlett-Packard.

This document contains proprietary information which is protected by copyright. All rights rese
No part of this document may be photocopied, reproduced, or translated to another language w
the prior written consent of Hewlett-Packard Company.

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclosure by government is subject to
restrictions as set forth in subdivision (c) (1) (ii) of the rights in Technical Data and Computer Sof
Clause at DFARS 252.227.7013.
Hewlett-Packard Co., 3000 Hanover Street, Palo Alto, CA 94304.

Support Address: The HP E2920 PCI Series is a product of:

Hewlett-Packard GmbH
Boeblingen Instruments Division

Herrenbergerstrasse 130
71034 Boeblingen

Germany

If you need further information on how to install the HP E2920 PCI Series you can contac
nearest HP office, or the factory directly by:

Fax No: (+49) 7031-14-6532 or
E-mail address: pl24_support@bbn.hp.com
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Precautions
• The operating temperature of the Altera IC’s on the PCI Exerciser and Analyzer card

be in excess of 70oC (158oF). Please take care when handling the board during opera
and when removing the card.

• The PCI Exerciser and Analyzer card is not designed for outdoor use. Do not expos
any of its component parts to rain or other excessive moisture.

• Protect the PCI Exerciser and Analyzer card from humidity and temperature change
which could cause condensation on the modules.

• Do not operate the PCI Exerciser and Analyzer card in the presence of flammable g
fumes or powders. Operation of any electrical instrument in such an environment co
tutes a definite safety hazard.

• There are no serviceable parts on the PCI Exerciser and Analyzer card. Do not attem
vice or adjustment.

• The PCI Exerciser and Analyzer card or any of its component parts should not be ex
to excess shock or vibration and should therefore not be used for environmental tes

• ATTENTION! STATIC SENSITIVE DEVICES:
Because electrostatic sensitive components are exposed on the PCI Exerciser and A
card, proper care should be taken when handling it. Handle the PCI Exerciser and An
card as little as possible and with care.

Electrostatic Discharge (IEC 801-2:1991):

Under normal operating conditions an electrostatic discharge of 
to 4kV contact-discharge or 8kV air-discharge may cause errone
behavior of the E2925A.
Keep such electrical discharges away from operating instrument

Electromagnetic Immunity (IEC 801-3:1992):

Under normal operating conditions an electrical field of up to 3 V/
may cause erroneous behavior of the E2925A.
Keep such electrical fields away from operating instrument.

Fast Transients (IEC801-4:1988):

Under normal operating conditions fast transients of up to 0.5kV
applied to I/O-cables or up to 1kV to power line cables may cause
erroneous behavior of the E2910A.
Keep such fast transients away from cables on operating instrum
3
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Europe - Declaration Of Conformity

We declare that the system:

conforms to the following standards:

Supplementary Information:

The product herewith complies with the requirements of the
- Low Voltage Directive (73/23/EEC) and the
- EMC Directive (89/336/EEC).

(1) The product exceeds the requirements in setups given from the standards. A Technical Co
tion File (TCF) got a certificate (#K129923H) from a Competent Body. For installations in an
country, the Site Attenuation Requirement must be attended to. They are stated in this Inst
Guide E2925-91010, see “EU Regulatory Instruction - Site Attenuation Requirements” on pag

Manufacturer: Hewlett-Packard GmbH
Boeblingen Instruments Division
Herrenberger Str.130
D-71034 Boeblingen, Germany

HP E2925A PCI Exerciser & Analyzer Card

Safety: IEC 1010-1:1990 +A1:1992 EN61010-1:1993

EMC: EN 55011:1991 / CISPR 11  Group 1, Class A(1)

EN 50082-1:1992

IEC 801-2:1991 ESD: 4kV cd, 8kV ad

IEC 801-3:1992 Radiated Immunity: 3V/m

IEC 801-4:1988 Fast Transients: 0.5kV, 1kV

Boeblingen, 22nd November 1996 Hans Baisch

Regulations Consultant
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Installation Procedure
The following instructions relate to a first time installation of the HP E2925A PCI Bus card. 
case of upgrading with new software add-on products, please see chapter , Licensing of So
Add-on Products, on page 19.

1 Check the Content of the Shipment

Verify that your shipment contains the following

If ordered, the following options will be included:

PCI Exerciser and Analyzer Card
Installation CD and this Guide

Hardware Dongle ID ModuleRS232 Cable

Option 001: Option 002:
External Power Supply Fast Host Interface Card +

Option 003:
HP Logic Analyzer Adapter

Bi-Directional Centronics Cable

Option 004:
Generic Logic Analyzer Adapter
(not shown)

or:
7
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2 Option 002 Only: Install Fast Host Interface Card

This option is designed for applications that require extensive data download/upload from t
external test controller (host) to the E2925A card. It improves the data throughput by using
directional Centronics interface (peak datarate 150k byte/s) instead of the RS232 serial lin
bit/s).With this option the ISA Fast Host Interface card must be installed in the host PC. Th
option is supported by Windows NT (GUI and C Application Programming Interface - C-AP
and by DOS C-API programs. It is not supported under Windows 95.

The Fast Host Interface Card is shipped to you with the following settings:

• LPT2 enabled

• Address 278-27F\h

• EPP mode

• Channel A (Channel B is not supported)

The following tables show the card jumper positions for the above settings:

If using the Fast Host Interface with the default settings, you must set the Test Card Configu
in the GUI to Bidirectional Centronics on LPT, see “Configure the Interface Port” on page 1

NOTE: If your host PC parallel port supports Centronics EPP 1.7 or EPP 1.8, then this can b
instead of the ISA Fast Host Interface card.

Table 1 Fast Host Interface Card Configuration for LPT1 and LP2

Channel A
(LPT-A)

Address JP1-A
Position

JP1-B
Position

JP1-C
Position

LPT1 378-37F\h 2=3 2=3 2=3

LPT2 (default) 278-27F\h 1=2 2=3 2=3

Table 2 Fast Host Interface Card Configuration for Disabling Channel B

Channel B
(LPT-B)

Address JP3-A
Position

JP3-B
Position

JP3-C
Position

Disabled 1=2 1=2 1=2

Table 3 Fast Host Interface Card Configuration for EPP Mode

Mode JP1-D
Position

JP1-E
Position

EPP 2=3 1=2
8
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3 Install Software

The software media contains all software products. Running of these products is controlled
the Hardware Dongle ID module.

1 Insert the installation CD into your host computer CD drive

2 Access the CD-ROM drive and run the installation executablesetup.exe by double clicking on
the file. The directory structure on the CD-ROM is organized by installation platform. You 
find a set of disks under the Windows NT and Windows 95 directories. The setup.exe fi
located under DISK1. A set of installation floppy disks may be created by copying each D
directory to a floppy disk.

Follow the on-screen instructions to install the software.

The requirements to run Graphical User Interface software are:

The files required by the DOS installation can be found in the DOS directory. To install the 
files:

1 Create a directory on the destination drive.

2 Copy the DOS directory structure to the installation directory.

3 Uncompress the postscript User’s Guide by typing ‘install’ in the \help subdirectory.

Table 4 Host PC Requirements

Resource Requirement/Recommendation

Computer IBM-PC or 100% compatible with recommended minimum 90MHz
Pentium CPU and CD-ROM drive.

Graphics Graphics: 800 x 600 required, recommended 1024 x 768 SVGA

Operating System Windows 95 or Windows NT for GUI. C-API sources available for
compilation under other operating systems

Memory 16MB minimum, 24MB recommended

Hard Disk Minimum of 50MB free disk space, 100MB recommended

ISA Slots For option 002 Fast Host Interface, 1 ISA Slot is required to host the 
directional Centronics Card. Not supported under Windows 95.
Alternatively, if your host PC has a Centronics EPP 1.7 or 1.9
compatible parallel port then this may be used instead.

Interfaces An RS232 port is required unless you are using the Fast Host Interfa
Option 002, or accessing the card through PCI. A parallel port is
required for the Software ID module.
9



During installation the following directory structure is created in the installation directory:

NT and Windows 95 Platforms

Directory File types Description

\bin .exe .dll .dat .ini Executables and DLLs

\help .pdf .ps Acrobat readable and printable postscript files

\data User data files

\capi\src .c .h The C-API source files

\capi\include .h For DLLs and DLL recompilation

\capi\ntdrv .sys .h For driver recompilation (NT Only)

\lib\bc Borland C++ import library

\lib\ms .lib MS Visual C++ import library

\libdos\bc .lib Borland static library (currently not available)

\libdos\ms Microsoft static library

\samples\capi .mdp .c MS Visual C++ template and examples

\samples\GUI .tst Sample Analyzer capture data

\hw\e2925a .exo .hex Hardware BIOS, and programmable hardware

\acrobat acrobat reader executable, fonts and help files

\la\e2925a ._e HP 16550 analyzer setup files. These contain the
analyzer formats for option 003
10
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The file readme.txt in the installation directory should be read before installing this product.

4 Connect Hardware Dongle ID Module to Host Computer Parallel Port

The Hardware Dongle ID module (or dongle) contains licensing information required to run
software product add-ons such as options and additional Graphical User Interfaces (e.g.
HP E2970A PCI Analyzer, and HP E2971A PCI Exerciser). It is not needed to run the basic
E2925A product.

NOTE: The dongle must be connected to the parallel port of the host controller to enab
software add-ons to run. It is recommended to keep this in a safe place if no host PC 
in the current application.

Directory File types Description

\capi\src .c .h The C-API source files

\capi\include .h For DLLs and DLL recompilation

\libdos\bc Borland static library (currently not available)

\libdos\ms Microsoft static library

\samples .c  C++ template

\help .p_  compressed postscript User’s Guide

\readme.txt  information on installing and compiling the DOS
libraries

Host PC

Hardware Dongle ID Module
11
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5 Option 003 and 004 Only: Fix LA Adapter to the E2925A Card

The option 003 adapter allows you to connect a Logic Analyzer directly to the card

Ensure that you have the correct adapter. There are two types:

Option 003 analyzer adapter for the HP 16550. The connections on this adapter have re
terminations.

Option 004 for all other analyzers.

NOTE: The connections on the option 004 Generic Logic Analyzer adapter are not terminate
must be terminated in accordance with the requirements of the analyzer used.

Align the boards using the 3 edge connectors and press firmly together.

Fix the boards together using the screws provided.

Logic Analyzer Settings for 16550 HP analyzers are shipped as part of the software releas
These can be found in the installation \la directory. Copy these on to floppy disk, and load t
analyzer with the formats. For other logic analyzers the pinout information in the users guid
be used to set up the analyzer.

NOTE: The on-board logic analyzer must be running to enable the logic analyzer output buf

Open the Command Line Interface Editor Window (see item 12, Accessing the Com
Line Interface, on page 16), and type “arun” at the ‘Best2’ prompt, then press the [E
or [Return] key.

6 Install the E2925A Card into your System Under Test

Insert the E2925A card (with LA Adapter, if fitted) into an empty PCI slot in your system un
test.

=

12
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7 Connect Interface Cable (RS232 or Bi-Directional Centronics)

If using the serial RS232 interface, connect the RS232 Cable from a serial port on the host
the serial interface on the front of E2925A card.

If using the Fast Host interface, connect the Bi-directional Centronics cable between the int
card in the host PC and the Centronics connector on the back of the E2925A card.

Bi-directional Centronics Connection

RS232 Connection
13
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8 Option 001: Connect External Power Supply Unit (PSU)

If using the external power supply, connect the power cable from the PSU to the power con
on the back of the E2925A card.

The power supply used by the E2925A card is determined by the VCC jumper. Set this jum
‘Ext’ to enable the board to use the external power supply.

9 Apply Power

WARNING: The operating temperature of the Altera IC’s on the E2925A card may
be in excess of 70oC (158 oF). Please take care when handling the
board during operation and when removing the card.

If using the external power supply (option 001), connect the
power cable and switch on the power.

If power is supplied from the system under test, switch on your
system under test.

The top right LED on the E2925A card faceplate indicates that
stable power is being applied to the card

PSU Connector

J104

J402

VCC
PCI

Ext

Stable Power
Indicator
14
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10 Start the Software

The software installation creates a Windows Progra
Group which includes several icons:

To start the software, double click on the “E2920
GUI” icon. This opens the E2925A Main Window.

The GUI provides as standard, a command line
interface (CLI) for controlling the E2925A card and allows access to all E2925A functionalit
from the GUI. CLI commands can also be entered into an ASCII format file and run using th
filename” CLI command. The additional GUI features depend on which add-on GUI produc
you ordered (for example, E2970A PCI Analyzer GUI and E2971A PCI Exerciser GUI).

11 Configure the Interface Port

The standard GUI also provides some system setup windows. Before you can use the GUI
control the E2925A card, you must first configure the interface port you will use to commun
with the card.

1 From the Main Window Setup menu, select Testcard Configuration:

2 From the Testcard Configuration window, select the Host Interface port you are using:
15
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The system under test is the Host controller and communicates using PCI bios calls.

RS232
Host is an external controller communicating over the serial interface.

Bi-directional Centronics
Host is an external controller communicating using the Fast Host Interface Card.

12 Accessing the Command Line Interface

The Command Line Interface can be accessed from the Windows->Command Line ... m
item. Help on using the CLI window is available from Help->Help on Window... For inform
tion on the available commands see the User’s Guide C-API reference. Examples are a
sented in the User’s Guide.

13 Accessing User Documentation

User documentation is delivered on-line in a “pdf” file format. This can read by double click
on the User Guide icon in the HPBEST Program Group:
16
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An Adobe Acrobat reader is shipped as part of the software release. If you prefer printed
documentation, you can print this out on a local printer using the File>Print option of the Acr
Reader. Alternatively, a postscript file is delivered in the documentation directory on the CD
ROM.

If you click the Help menu in the GUI, you get a Help topic relating to the window you are in

When using the Acrobat Reader it is highly recommended to use the Bookmarks utility to
navigate. To turn this option on, press <CTRL> 7, while running the Acrobat Reader. The
bookmark utility consists of a list of hierarchical topic titles which can be clicked on to take 
quickly to a section in the documentation. All main sections within the documentation are
bookmarked. To maximize readability, View>Fit Width is also recommended:

14 Performing Hardware Update after a Software Update/Upgrade

Software updates, including adding new product options or software add-on products shou
installed in a separate directory for each installation. It is therefore recommended that you 
keep your data in the installation directory.

Software updates may require re-programming of the programmable hardware on the Main
Board. Every software release is shipped with the corresponding programmable hardware 

Product options and software add-ons can be enabled from the Register Product Options w
This window may be accessed from the Testcard Configuration window which is accessible
the Setup menu of the main window.

View Bookmarks button

Bookmarks
17
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After making a new software installation, you can check if a hardware update is necessary
the Check HW menu option of the Setup menu, in the E2920 Main Window:

If the Check hardware fails then you need to perform an update of the Main Board program
hardware:

To Update Programmable Hardware

The hardware update jumpers can be located in the top right hand corner of the Main Boar

1 Set J104 and J402 to their programming position (left
side):

2 If using the serial port interface, ensure that the baud rate
is 9600.

3 Select the HW Config > Update menu option (see above)

4 Follow the on-screen instructions to reprogram the BIOS
and on-board statemachines.

5 After the update is complete, remove power from the system, and set J104 and J402 to
passive position (right side)

6 Re-apply power, and perform a Check HW once again. Everything should pass this tim

J104

J402
18
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Licensing of Software Add-on Products
In factory pre-configured systems all licenses are already installed and are ready to use.

When software add-on products are ordered separately, the license activation key must be 
on customer site, after installation of the software add-on.

NOTE: Make sure that the HW-Dongle is connected to the host PC. The HW-Dongle was sh
already with the HP E2925A card.

With the shipment of the software add-on product you receive:

• The latest software revision

• This latest Installation Guide

• License-to-Use for the software add-on

• License Activation Key Request Fax, see next page
19
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1 To get your license activation keys, return the filled out License Activation Key Requ
Fax to the fax number given on the fax.

NOTE: Only one license for each software add-on may be activated for one HW-Dongle. I
have ordered multiple licenses for software add-ons, please send a separate reques
each HW-Dongle, specifying the corresponding HW-Dongle serial number and
software serial numbers.
20
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2 If the HW-Dongle is connected to your host PC you can find the serial number of the 
Dongle in the Help About menu option, in the E2920 Main Window

3 Copy the Dongle Serial No to the appropriate line of the fax sheet

Copy this Dongle
Serial No to the fax:
21



4 The software serial numbers you can find on the License-to-Use Sheet

Copy this serial number
to the fax sheet
22



5 Here is an example of a completed request fax
23



e
6 After we have received your request fax we will reply within two working days with th
permanent license activation keys

This are the relevant
license keys which
have to be entered in
step 10
24
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7 When you have received the permanent license activation keys you have to enter th
cense activation keys in the registration window. First install the latest software revis
you have received on the CD-ROM, please see item 3, Install Software, on page 9. Se
update the hardware, please see item 14, Performing Hardware Update after a Soft
Update/Upgrade, on page 17.
Then select Testcard Configuration menu option of the Setup menu, in the E2920 M
Window

8 Then select ‘Register Product Options...’ menu option of the ‘HW Config’ menu.

9 Select the software add-on product in the pull-down menu.If there is no HW-Dongle
then please connect the HW-Dongle and repeat from step 7.

10 Then type in the 20 character License Activation Key in the “Key” field and press the [O
25
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11 When the key is typed in correctly and the correct HW-Dongle is used a dialog wind
pops up stating that the software upgrade and licensing is successfully finished. Pre
[OK] button in this dialog window.

In cases where the licensing is not successful even after several times of repeating 
step 7, please contact the e-mail address of Hewlett Packard shown on the request fa
or use the support e-mail address shown on page 2 of this guide.

12 Repeat step 9 to step 11 for each software add-on to activate for the same HW-Dong
each HW-Dongle repeat step 7 to step 11.

13 After the upgrade and licensing the E2920 Main Window may look like the following

14 After activation of software add-on license of a HW-Dongle, please mark the added lic
on the dongle’s label. For example:

Mark the
added
license
26
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EU Regulatory Instruction - Site Attenuation Requirements
Introduction:
For all products installed in Europe (EEC Countries), the requirements of the EC Directive on 
89/336/EEC have to be adhered to.
For this system, the derived standards as well as the classes are noted in the Declaration of Co
in this guide.

Conformity from a Competent Body:
The EMC Directive (Para. 10.2) requires a Technical Construction File (TCF) with a Declarati
Conformity from a Competent Body (CB). For the Site Attenuation Requirements and the me
stated herein, a review by a CB is mandatory.

Technical Rational:
The product/system concerned here meets all requirements, except the Radiated Emiss
CISPR11/EN55011. This is mainly driven by cables, which provide limited shielding for higher
quencies and thus cause electromagnetic radiation like from an antenna.
In order to meet the requirements in situ, prevention has to be considered, before the product
is turned on for its intended application. The methods described herein are sufficient to keep t
tem within the given limits of the standard.
For preparation of the data for the required site attenuation, the system was evaluated in a test
radiation values exceeding the limits were taken as reference of the required Target Values 
installation instruction. This way, the subtraction of the site attenuation from the measured rad
leads to a radiation level, requested by the standard.

Site Attenuation:
This document describes the methods for a Site Attenuation to meet the requirements of Class
HP E2925A PCI Exerciser & Analyzer Card System
the required value for Target Site Attenuation is: 16 dB

Installation Instruction:
If your site has got an allowance from a local (PTT) agency to exceed the levels of radiation, th
ceeded level has to be considered. In case of i.e. +10 dB, subtract this ratio from the Target S
tenuation.

Based on the location where the system is to be installed, obtain the Available Site Attenuatio
calculating method is described in the sectionCalculating Method. Some site preparations may hav
to be done. Try to optimize the location as well as the consideration of available walls or walls
installed.

NOTE: When the location is finally determined, make an overall calculation of the Available
Attenuation.

The Available Site Attenuation has to be greater than the Target Site Attenuation!
27
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In case that this requirement is not achievable, consider other methods like the use of a Shielde
with specified shielding performance. Other shielding methods like conductive wall paper, 
walls, etc. require an approval test ("in situ") by a local (PTT) agency. Appropriate arrangement
to be organized. Install the system as described in the Installation Manual.
The product installation then meets the requirements for radiation levels of Class A, of CISP
EN55011.

Calculating Method:
To obtain the necessary attenuation at the customer's site:

15 The attenuation of a concrete wall (W) (without any openings) = 10 dB

16 The distance (D) (the distance from the equipment to the exterior wall plus 30 meter
creases the attenuation by X and can be calculated as follows:
X =  20 * log (D/30)          where: X = attenuation in dB, D= distance in meters

17 The total attenuation (A) is calculated as follows:
A= n * W + X
where:A= total attenuation in dB, n= number of concrete walls within distance D,
W = 10 (dB)

This method yields to the following requirements at the installation site:

Req. Site Attn./dB Walls/n Remaining Attn.
Requirement/dB

Real Estate Border
Distance/m

16 0 16 189

16 1 6 60

16 2 -4 19
28
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